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Dear Candidate,  

 

In preparation for the Print & Digital Media Publication Using Adobe InDesign certification exam, 
we’ve put together a set of practice materials and example exam items for you to review. What you’ll 
find in this packet are: 

• Topic areas and objectives for the exam. 

• Links to practice tutorials and files. 

• Practice exam items. 

We’ve assembled excerpted material from the Adobe InDesign CC Learn and Support page, and the 
Visual Design curriculum to highlight a few of the more challenging techniques covered on the exam.  
You can work through these technical guides and with the provided image files (provided separately). 
Additionally, we’ve included the certification objectives so that you are aware of the elements that are 
covered on the exam. Finally, we’ve included practice exam items to give you a feel for some of the 
items.   

These materials are meant to help you familiarize yourself with the areas of the exam so are not 
comprehensive across all the objectives.  

 

Thank you,  

Adobe Education 

  

https://helpx.adobe.com/support/indesign.html
https://edex.adobe.com/visual-design
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Adobe Certified Associate in Print & Digital Media 
Publication Using Adobe InDesign (2015) 

 

Exam Structure 
The following lists the topic areas for the exam: 

• Setting project requirements 

• Understanding Print and Digital Media Publications  

• Understanding Adobe InDesign CC 

• Creating Print and Digital Media Publications Using Adobe Illustrator  

• Publish, Export, and Archive Page Layouts Using Adobe InDesign 

Number of Questions and Time 

• 40 questions 

• 50 minutes 

 

Exam Objectives 
Domain 1.0 Setting Project Requirements 

1.1 Identify the purpose, audience, and audience needs for preparing print and digital media 
publications. 

1.2 Summarize how designers make decisions about the type of content to include in a project, 
including considerations such as copyright, project fit, permissions, and licensing. 

1.3 Demonstrate knowledge of project management tasks and responsibilities. 

1.4 Communicate with others (such as peers and clients) about design plans. 

Domain 2.0 Understanding Print and Digital Media Publications     
2.1 Understand key terminology related to print and digital media publications. 

2.2 Demonstrate knowledge of basic design principles and best practices employed in the print 
and digital media publication industry. 

2.3 Demonstrate knowledge of typography and its use in the print and digital publication 
industry. 

2.4 Demonstrate knowledge of color and its use in print and digital publications. 

2.5  Demonstrate knowledge of the appropriate properties of print, web, and digital publication 
designs. 

Domain 3.0 Understanding Adobe InDesign CC 
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3.1  Identify elements of the InDesign CC interface and demonstrate knowledge of their 
functions. 

3.2 Define the functions of commonly used tools including selection tools, Frame tools, type 
tools, drawing tools, Line tool etc. 

3.3 Navigate, organize, and customize the workspace. 

3.4  Use non-printing design tools in the interface, such as rulers, guides, grids, bleeds, and slugs. 

3.5 Demonstrate knowledge of layers. 

3.6  Manage colors, swatches, and gradients. 

3.7  Create, use, and manager object styles. 

3.8  Create, use, and manage character and paragraph styles. 

Domain 4.0 Creating Print and Digital Media Publications Using Adobe InDesign 

4.1 Create a new project.  

4.2  Create, manage, and use frames in a publication design. 

4.3  Add text to a page layout. 

4.4  Add graphic, image, and video content to a page layout. 

4.5  Create special page elements using InDesign tools, such as a table of contents, an index, 
Library files, and previously placed content. 

4.6  Add interactive elements such as hyperlinks, interactive media objects, HTML5, and video; 
and assign triggers for different actions. 

Domain 5.0 Publish, Export, and Archive Page Layouts Using Adobe InDesign 

5.1  Prepare publications for print. 

5.2  Prepare page layouts for export to digital media publications such as multiscreen devices 
and FOLIO files for Digital Publishing Suite. 
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Overview of Adobe InDesign CC 
Watch this quick video titled see what you can create with InDesign and get to know the industry-
standard publishing app that lets you design and publish high-quality documents across a full 
spectrum of digital and print media. 

After watching this quick video start getting to know the InDesign workspace. 

 

InDesign Workspace Overview 

You create and manipulate your documents and files using various elements, such as panels, bars, and 
windows. Any arrangement of these elements is called a workspace. The workspaces of the different 
applications in Adobe® Creative Cloud® share the same appearance so that you can move between the 
applications easily. You can also adapt each application to the way you work by selecting from several 
preset workspaces or by creating one of your own. 

Although the default workspace layout varies in different products, you manipulate the elements 
much the same way in all of them. 

• The Application bar across the top contains a workspace switcher, menus (Windows only), and 
other application controls. On the Mac for certain products, you can show or hide it using the 
Window menu. 

• The Tools panel contains tools for creating and editing images, artwork, page elements, and so 
on. Related tools are grouped. 

• The Control panel displays options for the currently selected tool. In Illustrator, the Control 
panel displays options for the currently selected object. (In Adobe Photoshop® this is known as 
the Options bar. In Adobe Flash®, Adobe Dreamweaver®, and Adobe Fireworks® this is known 
as the Property Inspector and includes properties of the currently selected element.) 

• The Document window displays the file you’re working on. Document windows can be tabbed 
and, in certain cases, grouped and docked. 

• Panels help you monitor and modify your work. Examples include the Timeline in Flash, the 
Brush panel in Illustrator, the Layers panel in Adobe Photoshop®, and the CSS Styles panel in 
Dreamweaver. Panels can be grouped, stacked, or docked. 

• The Application frame groups all the workspace elements in a single, integrated window that 
lets you treat the application as a single unit. When you move or resize the Application frame 
or any of its elements, all the elements within it respond to each other so none overlap. Panels 
don’t disappear when you switch applications or when you accidentally click out of the 
application. If you work with two or more applications, you can position each application side 
by side on the screen or on multiple monitors. 

If you are using a Mac and prefer the traditional, free-form user interface, you can turn off the 
Application frame. In Adobe inDesign, select Window > Application Frame to toggle it on or off.  

Watch this short video on InDesign basics to explore the primary tools you will interact with when you 
first launch the program. 

https://helpx.adobe.com/indesign/how-to/what-is-indesign.html
https://helpx.adobe.com/indesign/how-to/indesign-working-with-tools.html?playlist=/ccx/v1/collection/product/indesign/segment/designer/explevel/beginner/applaunch/orientation/collection.ccx.js
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For specific information about the Adobe InDesign workspace and general workflow tips review the 
following list of resources. 

• Recommended workflow for InDesign documents: learn how you can improve performance 
and prevent many problems throughout the design process by establishing a good workflow. 

• Workspace basics: learn how to manage windows and panels, save and switch workspaces, use 
the status bar, use the Navigator panel, and use the context menus. 

• Set preferences: Learn how to configure settings that InDesign uses to create documents and 
objects. Examples of preference settings are panel positions, measurement options, and display 
options for graphics and typography. 

• Create new documents: learn how to create a new document, set up pages, position margins 
and columns, and change grid settings. Additionally, here is a video tutorial on creating a new 
document that walks you through the start workspace. 

• View the workspace: learn how to zoom in and out of the InDesign workspace, adjust the view, 
work with additional windows, and use anti-aliasing.  

• Toolbox: learn all the tools in the InDesign toolbox: selection tools, drawing and type tools, 
transform tools, modification and navigation tools. 

 

Color 
Learn how to apply color in InDesign, create and edit tints, blend colors, apply gradients, and work 
with swatches. 

• Apply color: apply colors to object such as strokes or fills in an InDesign document. Apply 
colors to grayscale images and create color themes. 

• Use colors from imported graphics: use colors from imported graphics in InDesign, and use the 
Eyedropper tool to sample colors. 

• Work with swatches: use the Swatches panel to create color swatches and manage and import 
swatches in InDesign. 

• Mix inks: create and edit mixed ink swatches in InDesign and manage mixed ink groups. 

• Tints: create and edit tints in InDesign, and store tints in the Swatches panel. 

• Understand spot and process colors: learn about and use spot and process colors separately 
and together in InDesign. 

 

Transparency 
Learn how to apply transparency in InDesign. 

• Flatten transparent artwork: Flatten transparent artwork in Adobe InDesign into vector-based 
areas and rasterized areas. 

• Add transparency effects: Add transparency effects to objects using opacity and blends, 
overlap objects, or knock out shapes behind objects in InDesign. 

https://helpx.adobe.com/indesign/using/files-templates.html#recommended_workflow_for_indesign_documents
https://helpx.adobe.com/content/help/en/indesign/using/workspace-basics.html
https://helpx.adobe.com/content/help/en/indesign/using/setting-preferences.html
https://helpx.adobe.com/content/help/en/indesign/using/create-new-documents.html
https://helpx.adobe.com/indesign/how-to/new-document-in-indesign.html?playlist=/ccx/v1/collection/product/indesign/segment/designer/explevel/beginner/applaunch/orientation/collection.ccx.js
https://helpx.adobe.com/indesign/how-to/new-document-in-indesign.html?playlist=/ccx/v1/collection/product/indesign/segment/designer/explevel/beginner/applaunch/orientation/collection.ccx.js
https://helpx.adobe.com/content/help/en/indesign/using/viewing-workspace.html
https://helpx.adobe.com/content/help/en/indesign/using/toolbox.html
https://helpx.adobe.com/content/help/en/indesign/using/color-1.html
https://helpx.adobe.com/content/help/en/indesign/using/using-colors-imported-graphics.html
https://helpx.adobe.com/content/help/en/indesign/using/swatches.html
https://helpx.adobe.com/content/help/en/indesign/using/mixing-inks.html
https://helpx.adobe.com/content/help/en/indesign/using/tints.html
https://helpx.adobe.com/content/help/en/indesign/using/spot-process-colors.html
https://helpx.adobe.com/content/help/en/indesign/using/flattening-transparent-artwork.html
https://helpx.adobe.com/content/help/en/indesign/using/adding-transparency-effects.html
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• Blend colors: Blend colors in InDesign, isolate blending modes, and knock out objects within a 
group. 

 

Styles 
Use the following links to learn about the styles you can use in InDesign. 

• Paragraph and character styles: Learn how to add, apply, edit, delete, and override paragraph 
and character text styles in InDesign. 

• Object styles: Use object styles to format objects in an InDesign document with settings such 
as stroke, color transparency, and text wrap. 

• Drop caps and nested styles: Create drop caps, nested styles, and GREP styles in InDesign. 

• Work with styles: Learn how to duplicate, group, move, and reorder styles in InDesign. 

• Find/Change: find/Change text, objects, glyphs, and fonts in InDesign using the Find/Change 
dialog box. 

 

Layout and design 
In this section, you will learn about the basics of layout and design in InDesign.  

• Lay out frames and pages: learn about paths and frames, and automatic layout adjustments in 
InDesign.  

• Align and distribute objects: learn how to align objects using the gap tool, and distribute 
objects using Live Distribute in InDesign. 

• Resize elements of your layout: learn how to move and resize frames with this image-based 
tutorial. 

• About pages and spreads: Use pages and spreads in InDesign, add new pages to a document, 
and create color labels for thumbnails. 

• Add basic page numbering: learn how to add page numbers to InDesign documents. 

• Create book files: create, manage, convert, and print or output book files. 

• Create an index: learn how to create a simple keyword index or a comprehensive, detailed 
guide to the information in your book.  

• Create a table of contents: create and format a table of contents in Adobe InDesign that can 
list the contents of a book, display a list of illustrations, or include other information. 

• Grids: learn how to use a baseline grid, a layout grid, and a document grid in InDesign. 

See the documentation on layout and design in the InDesign User Guide for more 
information. 

 

Paragraph Formatting 

https://helpx.adobe.com/content/help/en/indesign/using/blending-colors.html
https://helpx.adobe.com/content/help/en/indesign/using/paragraph-character-styles.html
https://helpx.adobe.com/content/help/en/indesign/using/object-styles.html
https://helpx.adobe.com/content/help/en/indesign/using/drop-caps-nested-styles.html
https://helpx.adobe.com/content/help/en/indesign/using/styles.html
https://helpx.adobe.com/content/help/en/indesign/using/find-change.html
https://helpx.adobe.com/indesign/using/laying-out-frames-pages.html
https://helpx.adobe.com/content/help/en/indesign/using/aligning-distributing-objects.html
https://helpx.adobe.com/indesign/how-to/resize-content-frame.html?playlist=/ccx/v1/collection/product/indesign/segment/designer/explevel/beginner/applaunch/orientation/collection.ccx.js
https://helpx.adobe.com/content/help/en/indesign/using/pages-spreads.html
https://helpx.adobe.com/content/help/en/indesign/using/layout-design-9.html
https://helpx.adobe.com/content/help/en/indesign/using/creating-book-files.html
https://helpx.adobe.com/content/help/en/indesign/using/creating-index.html
https://helpx.adobe.com/content/help/en/indesign/using/creating-table-contents.html
https://helpx.adobe.com/content/help/en/indesign/using/grids.html
https://helpx.adobe.com/indesign/user-guide.html?topic=/indesign/morehelp/layout_and_design.ug.js
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The following list of resources will help you learn the Text features in InDesign. 

• Create text and text frames: create text and text frames, and change text frame properties and 
text direction in InDesign. Additionally, this tutorial on creating a layout with texts and graphics 
shows you how to create and use frames. 

• Add text to frames: add, paste, drag and drop, and place text in InDesign frames and 
documents.  

• Threading text: learn how to thread text among frames in InDesign. Also referred to as linking 
text frames or linking text boxes. 

• Align text: align or justify text, align paragraphs to a baseline grid, and span or split columns in 
Adobe InDesign. 

• Tabs and indents: set and repeat tabs; move, delete, and edit tab settings; and set indents in 
InDesign. 

• Wrap text around objects: Learn how to wrap text around any object, including text frames, 
imported images, and objects you draw in InDesign. 

• Text composition: using the Adobe Paragraph Composer or the Adobe Single-Line composer, 
compose and hyphenate text in InDesign, and change justification settings. 

• Format paragraphs: format paragraphs, adjust spacing, use drop caps, add rules, and control 
paragraph breaks in InDesign. 

• Line and character spacing: learn how to set the leading, shift the baseline, and adjust the 
kerning and tracking in Adobe Illustrator. 

• Bullets and numbering: Learn how to create and manage lists with bullets and numbering in 
InDesign. 

 

Character Formatting 
Learn more about how to format text and use fonts in InDesign. 

• Using fonts: install and use fonts in InDesign, including Adobe Typekit fonts and OpenType 
fonts. 

• Format characters: apply baseline shift, change the color and gradient of text, and add 
transparency effects to text. 

• Edit text: edit text, view hidden characters, add breaks, and use the Story Editor in InDesign. 

• Format type: learn about formatting text, such as how to change appearance of characters, 
work with OpenType fonts, and more. 

• Kerning and tracking: Apply and adjust kerning and tracking to text in InDesign. Kerning is the 
process of adding or subtracting space between specific pairs of characters. Tracking is the 
process of loosening or tightening a block of text 

• Leading: apply and change leading in InDesign. 

• Character and paragraph styles: learn about working with character and paragraph styles 

https://helpx.adobe.com/content/help/en/indesign/using/creating-text-text-frames.html
https://helpx.adobe.com/indesign/how-to/indesign-add-text-to-frames.html?playlist=/ccx/v1/collection/product/indesign/segment/designer/explevel/beginner/applaunch/orientation/collection.ccx.js
https://helpx.adobe.com/content/help/en/indesign/using/adding-text-frames.html
https://helpx.adobe.com/content/help/en/indesign/using/threading-text.html
https://helpx.adobe.com/content/help/en/indesign/using/aligning-text.html
https://helpx.adobe.com/content/help/en/indesign/using/tabs-indents.html
https://helpx.adobe.com/content/help/en/indesign/using/text-wrap.html
https://helpx.adobe.com/content/help/en/indesign/using/text-composition.html
https://helpx.adobe.com/content/help/en/indesign/using/formatting-paragraphs.html
https://helpx.adobe.com/content/help/en/illustrator/using/line-character-spacing.html
https://helpx.adobe.com/content/help/en/indesign/using/bullets-numbering.html
https://helpx.adobe.com/content/help/en/indesign/using/using-fonts.html
https://helpx.adobe.com/content/help/en/indesign/using/formatting-characters.html
https://helpx.adobe.com/content/help/en/indesign/using/editing-text.html
https://helpx.adobe.com/content/help/en/illustrator/using/formatting-type.html
https://helpx.adobe.com/content/help/en/indesign/using/kerning-tracking.html
https://helpx.adobe.com/content/help/en/indesign/using/leading.html
https://helpx.adobe.com/content/help/en/illustrator/using/character-paragraph-styles.html
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• Format text: learn how to format text, copy type attributes, and use Quick Apply. 

• Glyphs and special characters: Insert glyphs and special characters, and create and edit custom 
glyphs in Adobe InDesign. 

 

Drawing and Painting 
Learn about drawing and painting in InDesign. 

• Apply line (stroke) settings: Apply line (stroke) settings in InDesign to define and save custom 
stroke styles. 

• Draw with lines and shapes: Learn how to draw lines and shapes using the toolbox in InDesign. 

• Edit paths: Edit paths in InDesign, select paths and segments, and add or delete anchor points. 

• Understand paths and shapes: Create simple paths, compound paths, and compound shapes, 
and combine them in a variety of ways in InDesign. 

• Draw with the Pencil tool: Learn how to draw and edit paths with the Pencil tool in InDesign. 

• Change corner appearance: Apply and change corner shapes in InDesign using the Corner 
Options dialog box, and use Live Corners. 

• Draw with the Pen tool: draw straight lines and curves with the Pen tool. 

• Compound paths and shapes: combine several paths and shapes into a single object.   

 

Interactivity 
Learn some of the basics about interactivity in InDesign with the list of resources below. 

• Hyperlinks: use this documentation to learn how to create and retain hyperlinks when you 
export to Adobe PDF or SWF in InDesign. Additionally, here is a video on creating, editing, and 
managing hyperlinks in InDesign. 

• Dynamic PDF documents: learn how to create interactive PDF documents with buttons, 
movies and sound clips, hyperlinks, bookmarks, and page transitions in InDesign. You can also 
watch the video tutorial that explains how to create an interactive PDF. 

• Bookmarks: create bookmarks for PDF in Adobe InDesign, and use the Bookmarks panel to 
rename, delete, and arrange bookmarks. 

• Buttons: add interactivity such as navigation to InDesign documents that you can export to the 
Fixed Layout EPUB format. 

For more resources on interactivity see the Interactivity section of the user guide. 

 

Tables 
Learn how to format, create, select, and edit tables in InDesign. 

https://helpx.adobe.com/content/help/en/indesign/using/formatting-text.html
https://helpx.adobe.com/content/help/en/indesign/using/glyphs-special-characters.html
https://helpx.adobe.com/content/help/en/indesign/using/applying-line-stroke-settings.html
https://helpx.adobe.com/content/help/en/indesign/using/drawing-line-or-shape-tools.html
https://helpx.adobe.com/content/help/en/indesign/using/editing-paths.html
https://helpx.adobe.com/content/help/en/indesign/using/paths-shapes.html
https://helpx.adobe.com/content/help/en/indesign/using/drawing-pencil-tool.html
https://helpx.adobe.com/content/help/en/indesign/using/change-corner-appearance.html
https://helpx.adobe.com/content/help/en/indesign/using/drawing-pen-tool.html
https://helpx.adobe.com/content/help/en/indesign/using/compound-paths-shapes.html
https://helpx.adobe.com/content/help/en/indesign/using/hyperlinks.html
https://helpx.adobe.com/indesign/how-to/simplified-hyperlinks-in-indesign.html?playlist=/ccx/v1/collection/product/indesign/topics/interactive-pdf/collection.ccx.js
https://helpx.adobe.com/indesign/how-to/simplified-hyperlinks-in-indesign.html?playlist=/ccx/v1/collection/product/indesign/topics/interactive-pdf/collection.ccx.js
https://helpx.adobe.com/content/help/en/indesign/using/dynamic-pdf-documents.html
https://helpx.adobe.com/indesign/how-to/indesign-create-interactive-pdf.html?playlist=/ccx/v1/collection/product/indesign/topics/interactive-pdf/collection.ccx.js
https://helpx.adobe.com/content/help/en/indesign/using/bookmarks.html
https://helpx.adobe.com/content/help/en/indesign/using/interactivity-5.html
https://helpx.adobe.com/indesign/user-guide.html?topic=/indesign/morehelp/interactivity.ug.js
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• Format tables: Format tables, resize columns and rows, and merge and split cells in Adobe 
InDesign. 

• Create tables: Create tables and add text, graphics, headers, and footers in InDesign. 

• Table and cell styles: Define, apply, and edit table and cell styles in InDesign. 

• Select and edit tables: Select and edit tables in InDesign; insert and delete rows, columns, or 
tables; navigate within a table; and move or copy a table. 

• Table strokes and fills: Add table strokes and fills in InDesign, and learn about stroke and fill 
options. 

 

Export and Publish 
Learn how to export and publish your documents to EPUB, HTML, PDF, and more in InDesign. 

• Publish Online: Use Publish Online to publish a digital version of an InDesign document that 
works on any device, in any modern web browser. 

• Export content for EPUB: Export InDesign documents to a fixed layout EPUB format that 
allows you to include audio, video, and page navigation. 

• Adobe PDF options: Use the options in the Export Adobe PDF dialog box to export a file from 
InDesign. 

• Export content to HTML: Export content to HTML in InDesign CC to get content into web-
ready form. 

• Export to Adobe PDF: Learn how to export a document, a book, or selected documents as a 
single PDF file. You can also copy content from an InDesign layout to the Clipboard and create 
a PDF. Additionally, you can watch this video tutorial on creating a PDF for print. 

• Export to JPEG format: Use the Export command in InDesign to export a page, spread, or 
selected object in JPEG format. 

Additionally, there is specific documentation on printing-related features in InDesign and using 
InDesign for digital publications.  

 

 
  

https://helpx.adobe.com/content/help/en/indesign/using/formatting-tables.html
https://helpx.adobe.com/content/help/en/indesign/using/creating-tables.html
https://helpx.adobe.com/content/help/en/indesign/using/table-cell-styles.html
https://helpx.adobe.com/content/help/en/indesign/using/selecting-editing-tables.html
https://helpx.adobe.com/content/help/en/indesign/using/table-strokes-fills.html
https://helpx.adobe.com/content/help/en/indesign/using/publish-online.html
https://helpx.adobe.com/content/help/en/indesign/using/export-content-epub-cc.html
https://helpx.adobe.com/content/help/en/indesign/using/pdf-options.html
https://helpx.adobe.com/content/help/en/indesign/using/export-content-html-cc.html
https://helpx.adobe.com/content/help/en/indesign/using/exporting-publishing-pdf.html
https://helpx.adobe.com/indesign/how-to/indesign-create-pdf-for-print.html?playlist=/ccx/v1/collection/product/indesign/topics/interactive-pdf/collection.ccx.js
https://helpx.adobe.com/content/help/en/indesign/using/export-jpeg-format.html
https://helpx.adobe.com/indesign/user-guide.html?topic=/indesign/morehelp/printing.ug.js
https://helpx.adobe.com/indesign/user-guide.html?topic=/indesign/morehelp/digital-publications.ug.js
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Practice Tutorials and Files 
Below is a list of tutorials and resources from the Adobe Education Exchange and the Illustrator Learn 
& Support page that you can use in your classroom to prepare your students to be successful on the 
Visual Design Using Adobe Photoshop CC ACA exam.  

Create a professional resume 

Related objectives: Domain 1, Domain 2, Domain 3, Domain 4, and Domain 5 

Learn how to quickly create a high-impact resume starting with our sample file and then make it pop 
with color themes and professional-looking assets. 

Create a postcard 

Related objectives: Domain 1, Domain 2, Domain 3, Domain 4, and Domain 5 

Use basic tools and techniques in Adobe InDesign to create a professional-looking postcard that you 
can email, print, and share online. 

How to make a flyer 

Related objectives: Domain 1, Domain 2, Domain 3, Domain 4, and Domain 5 

Promote your next event with a flyer that grabs attention with colorful imagery, graphics, and 
attractive typography. 

Create a business card 

Related objectives: Domain 1, Domain 2, Domain 3, Domain 4, and Domain 5 

Customize a sample file to create a modern business card. 

Create a brochure 

Related objectives: Domain 1, Domain 2, Domain 3, Domain 4, and Domain 5 

This video tutorial guides you through the process of making a brochure from scratch.  

Create a one-page newsletter 

Related objectives: Domain 3, Domain 4, and Domain 5 

Learn how to create and apply patterns to many shapes in this tutorial, while experimenting with 
colors and shapes in patterns. 

Wrap text around images and graphics 

Related objectives: Domain 4 

Learn how to wrap text around simple objects and shapes. Customize the text flow to prevent 
unsightly gaps or visual breaks from appearing in the layout. 

Add images to table-based layouts 

Related objectives: Domain 4  

Check out additional projects, lesson plans, and teacher resources related to the ACA Photoshop 
exam on the Education Exchange.  

http://edex.adobe.com/
https://helpx.adobe.com/illustrator/tutorials.html
https://helpx.adobe.com/illustrator/tutorials.html
https://helpx.adobe.com/indesign/how-to/creative-resume-design.html?playlist=/ccx/v1/collection/product/indesign/segment/designer/explevel/beginner/applaunch/basictraining/collection.ccx.js
https://helpx.adobe.com/indesign/how-to/creative-resume-design.html?playlist=/ccx/v1/collection/product/indesign/segment/designer/explevel/beginner/applaunch/basictraining/collection.ccx.js
https://helpx.adobe.com/indesign/how-to/create-print-postcard-design.html?playlist=/ccx/v1/collection/product/indesign/segment/designer/explevel/beginner/applaunch/basictraining/collection.ccx.js
https://helpx.adobe.com/indesign/how-to/make-flyer.html?playlist=/ccx/v1/collection/product/indesign/segment/designer/explevel/beginner/applaunch/basictraining/collection.ccx.js
https://helpx.adobe.com/indesign/how-to/make-flyer.html?playlist=/ccx/v1/collection/product/indesign/segment/designer/explevel/beginner/applaunch/basictraining/collection.ccx.js
https://helpx.adobe.com/indesign/how-to/business-card-design.html?playlist=/ccx/v1/collection/product/indesign/segment/designer/explevel/beginner/applaunch/basictraining/collection.ccx.js
https://helpx.adobe.com/indesign/how-to/business-card-design.html?playlist=/ccx/v1/collection/product/indesign/segment/designer/explevel/beginner/applaunch/basictraining/collection.ccx.js
https://helpx.adobe.com/indesign/how-to/make-brochure.html?playlist=/ccx/v1/collection/product/indesign/segment/designer/explevel/beginner/applaunch/basictraining/collection.ccx.js
https://helpx.adobe.com/indesign/how-to/make-brochure.html?playlist=/ccx/v1/collection/product/indesign/segment/designer/explevel/beginner/applaunch/basictraining/collection.ccx.js
https://helpx.adobe.com/indesign/how-to/newsletter-template.html?playlist=/ccx/v1/collection/product/indesign/segment/designer/explevel/beginner/applaunch/continuinged/collection.ccx.js
https://helpx.adobe.com/indesign/how-to/newsletter-template.html?playlist=/ccx/v1/collection/product/indesign/segment/designer/explevel/beginner/applaunch/continuinged/collection.ccx.js
https://helpx.adobe.com/indesign/how-to/wrap-text-objects.html?playlist=/ccx/v1/collection/product/indesign/segment/designer/explevel/beginner/applaunch/continuinged/collection.ccx.js
https://helpx.adobe.com/indesign/how-to/wrap-text-objects.html?playlist=/ccx/v1/collection/product/indesign/segment/designer/explevel/beginner/applaunch/continuinged/collection.ccx.js
https://helpx.adobe.com/indesign/how-to/insert-image-table-cell.html?playlist=/ccx/v1/collection/product/indesign/segment/designer/explevel/beginner/applaunch/continuinged/collection.ccx.js
https://helpx.adobe.com/indesign/how-to/insert-image-table-cell.html?playlist=/ccx/v1/collection/product/indesign/segment/designer/explevel/beginner/applaunch/continuinged/collection.ccx.js
https://edex.adobe.com/
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Sample Questions for the ACA Study Guides 
InDesign CC 2015 

All sample questions have been provided by GMetrix. For information about full practice exams and 
additional exam preparation materials, visit GMetrix.com. 

 
Selected Response Questions 

 
1. What is the optical center in design? 

a. About 35% above complete center 
b. About 15% below complete center 
c. About 20% below complete center 
d. About 10% above complete center 

 

2. What is the definition of a gutter in 
design? 
a. The space around the entire page 
b. The space outside the artboard 
c. The space between each column 
d. The space between each artboard 

 

3. What does it mean to resample an 
image? 
a. Change the total number of pixels 
b. Change the actual size of the image 
c. Change the color scheme of the 

image 
d. Change the print vs. web option 

 

4. In which of the following situations 
would you use guides? 
a. When you need to line up images, 

text, etc. 
b. When you need to change default 

margins 
c. When you need to change the 

color of the design 

d. When you need to get more 
detailed information on your 
design 

 

5. Which of the following statements are 
true about placing graphics into 
InDesign using the Place dialog 
window? 
a. Placing a graphic is the same as 

copying and pasting the graphic 
b. Placing a graphic converts the 

graphic into a vector graphic 
c. A placed graphic has a link to its 

original file that will update when 
the original file is update outside 
InDesign 

d. Placing a graphic compresses it 
and reduces the file size 

 

6. What is the definition of typography? 
a. The color choice of the text 
b. The arrangement and type of fonts 

used 
c. A specific font family 
d. The term used when referring to 

printing text 
 

7. What is a book file? 
a. A collection of documents that 

share styles, swatches and master 
pages 

b. A collection of book marks that are 
in your document 

c. A file that InDesign creates to save 
document preferences 

http://gmetrix.com/
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d. A file that keeps a history of your 
actions 

Simulation Questions 
When taking the actual exam, you will complete each of the tasks with your mouse in a simulated 
manner, but for this study guide we recommend that you practice by writing out the steps. In the space 
provided. 

1. Fit the spread to the window. 
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2. Assign a Fly in from Right animation with a duration of 2 seconds to the 
vacationAirLogo.png image. 
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3. Using the Swatches panel, create a new swatch named CD Cover using the background of 
the CD cover. 
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4. Add the B-master page elements to the third page of the document. 
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5. Change the page size to Legal. 
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6. Edit the [Basic Paragraph] style to have a First Line Indent of 0p5. 
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7. Place the Lyrics text document located in the Documents folder into the large rectangle 
frame on the page. 
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Scenario-Based Questions 
Scenario: 

You have been hired to design a new menu for a local burger restaurant.  The owner is very particular 
about maintaining their original style. 

1. Export the current document as an EPUB named Delicious Recipes without forced line 
breaks. 

 

 

 

 

 

 

 

 

 

 

 

 
2. Which three items should you discuss with the client before beginning your design? 

a. Mutual colleagues 
b. Contact information 
c. Scope of the project 
d. Contract questions 

 

3. Which of the following file types should you use so your client can print the menu in color? 
a. Greyscale 
b. TIFF 
c. RTF 
d. RGB 

 

4. In order to allow the menu to be viewed on multiple types of devices, which file type is the 
best to use? 
a. PDF (Print) 
b. JPEG 
c. EPUB 
d. PDF (interactive) 



 

 

Visual Design Using Adobe Photoshop CC Study Guide 

Adobe, the Adobe logo, Adobe Photoshop and Creative Cloud are either registered trademarks or trademarks of Adobe Systems 
Incorporated in the United States and/or other countries. All other trademarks are the property of their respective owners. 
 
© 2015 Adobe Systems Incorporated. All rights reserved. 
 

 

20 

Answer Key for Multiple Choice Questions: 

Selected Response Questions 
1. d 
2. c 
3. a 
4. a 
5. c 
6. b 
7. a 

Answer Key for Simulation Questions 
(answers below outline the steps to complete 
each simulation) 

Simulation 1: 
1. Select the View menu 
2. Select Fit Spread in Window 

Simulation 2: 
1. Select the vacationAirLogo.png image 
2. Select the Window menu 
3. Hover over Interactive and select 

Animation 
4. In the Animation Panel, select Fly In 

From Right from the Preset drop down 
menu 

5. Change the duration to 2 seconds 
6. Press ENTER 

Simulation 3:  
1. Click on the Selection tool 
2. Select the colored background 
3. Open the Swatches panel 
4. Click on Create Swatch 
5. Double Click New Gradient Swatch 
6. Name it CD Cover 
7. Click OK 

Simulation 4: 
1. Open the Pages panel 
2. Click and drag B-master to the third 

page 

Simulation 5: 
1. Select the File menu 
2. Select Document Setup 

3. In the Document Setup dialog box, 
change page size to Legal 

4. Click OK 

Simulation 6: 
1. Select the Type menu 
2. Select Paragraph Styles 
3. Double click [Basic Paragraph] 
4. In the New Paragraph Style dialogue 

box, select Indents and Spacing 
5. Change First Line Indent to 0p5 
6. Click OK 

Simulation 7: 
1. Select the large rectangle frame 
2. Select the File menu 
3. Select Place 
4. Select the Lyrics.docx file 
5. Click OK 

Answer Key for Scenario-Based Questions 
1. Steps to complete:  

1. Select the File menu 
2. Select Export… 
3. Name the file Delicious Recipes 
4. Change the Save as type to EPUB 
5. Click Save. 
6. Check Remove Forced Line Breaks 
7. Click OK 

2. b, c and d 
3. d 
4. d 
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